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PCM5122EVM-U and PCM5142EVM-U

The PCM5122/42 families of ICs are advanced segment, high-performance, software-programmable
stereo digital-to-analog converters (DACs). The PCM512x family employs fixed-function audio processing,
while the PCM514x family employs miniDSP audio processing. These devices employ internal line drivers
together with an internal PLL and BCLK reference, so that a serial clock signal (SCK) can be derived. The
advanced segment architecture enables excellent dynamic performance and an improved tolerance to
clock jitter, and the 2.1-Vgys ground-centered outputs eliminate the need for output dc blocking capacitors.
The PCM5122/42EVM-U is designed to support the PCM5121 (SLAS763), PCM5122 (SLAS763),
PCM5141 (SLAS759), and PCM5142 (SLAS759) DACs. The PCM5122/42EVM-U also employs the
TAS1020B USB controller and the SRC4392 asynchronous sample rate converter.

This User's Guide describes the operation of the PCM5122/42EVM-U and the Texas Instruments
CodecControl software. CodecControl provides a graphical user interface for supported Tl audio codecs.
The software is compatible with Microsoft® Windows® XP, Windows Vista, and Windows 7.
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Introduction

CodecControl software is intended to facilitate user evaluation of Tl audio codecs. It includes a wide range
of features, depending on the specific codec capabilities. The PCM5122/42EVM-U works together with the
CodecControl software. It connects to a PC via an available USB port and enumerates as a USB-class
audio device. Once configured with the CodecControl software, the EVM acts as a sound card that can
play back audio from the PC, depending on how the device is set up.

For a more detailed description of the PCM512x and PCM514x product line, refer to the product data
sheet available from the Texas Instruments web site at http://www.ti.com/.

Throughout this document, the abbreviation EVM and the term evaluation module are synonymous with
the PCM5122/42EVM-U. Unless otherwise noted, all references to the PCM5122/42 indicate complete
functionality of all four related devices (PCM5121, PCM5122, PCM5141 and PCM5142).

Information About Cautions and Warnings
This document contains caution statements.

CAUTION

This is an example of a caution statement. A caution statement describes a
situation that could potentially damage your software or equipment.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

Related Documentation from Texas Instruments

The following document provides information regarding TI's integrated circuits used in the assembly of the
PCM5122/42EVM-U. These documents are available from the Tl web site. The last character of the
literature number corresponds to the document revision that is current at the time of the writing of this
document. Newer revisions are available from the Tl web site at http://www.ti.com/.

Data Sheet Literature Number
PCM5121/22 SLAS763
PCM5141/42 SLAS759

TAS1020B SLES025A

SRC4392 SBFS029C

Applications Questions

If you have questions regarding either the use of this evaluation module or other Tl evaluation modules,
post a question in the Audio Converters forum at http://e2e.ti.com. Include the product in which you are
interested in the subject heading.

FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense is required to
take whatever measures may be required to correct this interference.
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2 PCM5122/42EVM-U

2.1 Electrostatic Discharge Warning

Many of the components on the PCM5122/42EVM-U are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION

Failure to observe ESD handling procedures may result in damage to EVM
components.

2.2 Overview

The PCM5122/42EVM-U is an easy to use, USB-interface, multi-functional system allowing for digital
optical/SPDIF, line or external I°S input with varying options for clock sources and clock frequencies.
Along with onboard sample rate conversion, this architecture allows for versatile use and testing of the
PCM5122/42 family of parts. Figure 1 shows the PCM5122/42EVM-U with the jumper and switch locations
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Figure 1. PCM5122/42EVM-U
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The PCM5122/42EVM-U is divided into two sections. The left half contains the digital and USB interface,
sample rate conversion, optical/SPDIF and RCA digital inputs, clock circuitry, and reset logic. The right
half contains the PCM5122/42 device and the analog circuitry accompanying it. Note that this half of the
PCM5122/42EVM-U is the portion required on a potential customer application. The left half is intended to
emulate a wide variety of testing options and scenarios for the PCM5122/42 device.

The digital interface section, or left half of the PCM5122/42EVM-U, is a four-layer design. However, the
PCM5122/42 device and analog circuitry, or right half of the EVM board, consists only of two layers.

For the analog circuitry surrounding the PCM5122/42 device, certain components can be removed at the
cost of higher performance. This configurability allows for optimal ratio between board space and
performance. Components such as C1, C3, C7, and C11 can all be removed for additional board space.

The PCM5122/42EVM-U features:

* USB Interface

* Analog output

* TX output (J5)

* Optical/SPDIF input

« IS input

» Hardware- and software-programmable options
» Digital audio interface test points

» Control interface test points

» PurePath™ Studio Software Functionality

2.3 EVM Connection Issues

Use the following steps to correct any connection issues between the host computer and EVM:

1. Download the latest TAS1020 USB firmware from the PCM5122EVM-U or PCM5142EVM-U product
pages.

2. Remove the USB cable from the EVM.

3. Short the SDA and SCL lines together by shorting the SDA and SCL EEPROM pins (pins 5 and 6 on
device U5 on the underside of EVM).

4. With SDA and SCL shorted, plug in the USB to the computer and wait 5 seconds.

5. In the computer's “Device Manager” the drive should now be recognized as “DFUDevice” or similar
title.

6. In the firmware folder downloaded in step 1, run “DFUTEST.exe". If the following message appears,
repeat steps 2-5.

Mo DFL devices found. Sat EEPROM s [2C Address to 10 Moo and
- restart thes program (oo i anything different than G00)

7. Click the “Program EVM” button in the DFUTEST GUI. Browse for “DFUEE.bin” located in the “image”
folder directory downloaded with the firmware. Click on the “DFUEE.bin” file once so it runs.

8. The following message should appear. Click the “OK” button.

!_\\‘ Sef EEPROMs [2C Address fo 103 L0000

9. “Device was successfully reset” message will appear. Follow the on-screen instruction and wait when

prompted to do so.
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10. After a few prompts, the “DFUTEST” automatically opens a second browser. Here, navigate to “USB-

xxX_441KHZ.bin” in the “Image” folder and click on it once.
11. A similar set of prompts should display. Follow the instructions.
12. After the program has completed, remove the EVM from USB and then reconnect.

13. The EVM is now ready for use.
EVM Block Diagram

Figure 2 shows the block diagram for the PCM5122/42EVM-U.

TAS1020B USB Microcontroller

Mini-USB

Interface

Selection

Audio Serial Port A Audio Serial Port B

il
il

W PCM51xx Analog
3 2.1 Vigys DAC Outputs

1

|
S/PDIF | DIR DIT
(RCA) |
' | RXCKO
|
sPOF L _ L ___ J
(Optical)

MCLK Select
ittt -
| | TAS1020B MCLK (11.288 MHz) :
' |
: |EXT 33VBNC MCLKI I

Figure 2. PCM5122/42EVM-U Block Diagram

Jumpers, Connectors, Test Points, Switches

Table 1 summarizes the connectors, test points, jumpers, and switches on the PCM5122/42EVM-U. When
running PurePath Studio ROM process flows, the correct jumper and switch setting will be displayed in the
main PurePath Studio window, once a process flow is opened.

Table 1. PCM5122/42EVM-U Headers, Test Points, Jumpers, and Switches

Connectors/Switch/Jumper/Test Point Description
Headers
w1 I2C/SPI Selection. Shunt pins 1-2 for SPI, 2-3 for I°C™ control mode
W2 I2C/SPI Selection. Shunt pins 1-2 for SPI, 2-3 for I1°C control mode
w3 Interface Connection. Shunt respective headers to send digital signals to
PCM5122/42.
w4 AVDD power. Shunt pins 1-2 or 3-4 for AVDD.
W5 MCLK/RXCKO select
Test Points
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Table 1. PCM5122/42EVM-U Headers, Test Points, Jumpers, and Switches (continued)

Connectors/Switch/Jumper/Test Point Description
TP1 GPIO4/GPIO4/MAST
TP2 GPIO5/GPIO5/ATTO
TP3 MC/SCL/ATT1
TP4 MOSI/SDA/ATT2
TP5 GPIO3/GPIO3/AGNS
TP6 GPIO2/ADR2/DOUT
TP7 MODE1
TP8 MS/MODE2/MODE2
TP9 FLT
TP10 SCK
TP11 BCK
TP12 DIN
TP13 LRCK
TP14 FMT
TP15 XSMT
TP16 PCM5122/42 analog output (R)
TP17 PCM5122/42 analog output (L)
TP18 1.8V
TP19 3.3V
TP20 3.3 VA
TP21 GND
TP22 GND
TP23 GND
TP24 AGND
TP25 AGND
TP26 AGND
TP27 BCLK (TAS1020B)
TP28 WCLK (TAS1020B)
TP29 DIN (TAS1020B)
TP30 SCL (TAS1020B)
TP31 SDA(TAS1020B)
TP32 RESET
Jumpers
J1 PCM5122/42 RCA analog output (R)
J2 PCM5122/42 RCA analog output (L)
J3 Mini-USB connection
J4 Optical S/PDIF input
J5 Coaxial S/PDIF input
J6 BNC external MCLK input
Switches
Swi EVM reset
SW2 Select EVM application
SwW3 MCLK select
LEDs
D2 RX lock
D3 SRC ready
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24.1

2.5

Clock Circuitry

SW3 allows for MCLK selection from multiple sources. The PCM5122/42EVM-U contains an external BNC
jack, J6, as well as one programmed oscillator that provides a clock frequency of 24.576 MHz. The
TAS1020B also provides a MCLK output; by default, this clock is used as the master clock for the
PCM5122/42EVM-U. Depending on the application requirements, the SRC4392 is also able to derive a
received clock output (RCKO) output based on the input clock frequency, and this derived clock output
can be used as the MCLK input for the PCM5122/42 as well. This option is enabled by setting a shunt in
position 1-2 (RXCKO) on the 3-pin jumper W5. If W5 has a shunt in position 2-3, then setting SW3
determines which MCLK source is used, as summarized in Table 2.

Table 2. SW3 Clock Selection

Setting A B C
Onboard MCLK from TAS1020B Low Low Low
External MCLK 3.3-V BNC Input High Low Low
24.576-MHz MCLK from PLL Y3 High High High

MCLK Source Matching

The SRC4392 is equipped with two audio serial data ports, each of which generates BCLK and LRCLK
signals. When the SRC4392 receives an S/PDIF input, it automatically derives the MCLK of the input,
which is sent to the RXCKO pin. Dividers are used to send the generated BLCK and LRCLK from the
audio ports (if they are in master mode). For certain use cases, the SRC4392 is set up so that these ports
are used. When routing through the audio serial ports on the SRC4392, it is important to use RXCKO as
the master clock source for the PCM5122/42. In order to ensure proper operation, the master clock source
must be synchronized to the bit and word clock supplied to the PCM5122/42. Therefore, the master clock
source for the PCM5122/42 must also be replicated from the digital input source, which is why RXCKO
must be chosen. If the master clock source for the PCM5122/42 is the onboard MCLK from the TAS1020B
USB controller, for example, then there is potential for synchronization mismatch between the master
clock supplied to the PCM5122/42 and the bit and word clocks being supplied to the PCM5122/42. For
use cases routing through the SRC4392 audio serial ports, look to jumper W5 for selecting RXCKO as the
master clock source, as opposed to one of the options chosen by adjusting SW3. The SRC4392 product
data sheet has additional routing information.

The PCM5122/42 devices contain an internal PLL and BCLK reference, so that the MCLK can be
generated internally. When using external I>S input directly into the W3 jumper, a MCLK can be derived
form the BCLK input. Refer to the PCM5122/42 product data sheet for more details.

Use Cases

PurePath Studio

251

The PCM512x and PCM514x are software programmable, and can be programmed using either
CodecControl software or PurePath Studio. For more information on enabling the audio processing
capabilities of the PCM512x with PurePath, see the (SLAA541). This application note provides a great
starting point regarding the usage of PurePath with PCM512x and PCM514x devices. Note that while the
PCM512x employs fixed-function audio processing, the PCM514x has full miniDSP processing, enabling
configurable process flows. However, the PCM514x can still run the ROM process flows used for the
PCM512x.

*  PCM5122 with PurePath Application Note (SLAA541)

Scripts and Setup

Most of the 1/O routing and clock frequency selection on the PCM5122/42 evaluation module is performed
by the SRC4392. Section 2.5.2 and Section 2.5.3 are two example scripts that adjust the SRC4392
registers accordingly, as well as set the proper jumper configurations.
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There are several use cases where the PCM5122/42EVM-U can be used. Depending on whether it is
USB playback, or optical/SPDIF input, for example, there may need to be changes made in the scripts and
jumper configuration to accommodate these cases. Likewise, the shunts on header W3 may need to be
installed accordingly. Section 2.5.2 and Section 2.5.3 are some example use cases for USB playback and
optical/SPDIF input, respectively.

25.2 USB Playback

# The following script is used for playback via USB
# RESET RESET THIS 1S MASTER RESET FOR SRC (48kHz)
# Page 0 = DEFAULT for Control

# Write to page O

w EO 7F 00

# Register 01, Bit 7 = 1 resets to default

d 100

w EO 01 80

# Delay 0.1 sec to allow part to reset

d 100

# Register 01, Bit 7 = 0 for normal operation

w EO 01 00

d 100

# w EO 7F 00

# Register 01, Bit 7 = 1 resets to default

H-——- Setup Port A ————-- #

# 24bit 12S, Master mode, DIR source, at mute

# Divide by 256, MCLK input source

# Unmute Port A Output

# power on port A and B

w EO 01 38

# set up port A as master, 24 bit 12S sourced from port B
w EO 03 19

# select MCLK as source at 256fs

w EO 04 01

# port B slave, 24 bit 12S

w EO 05 01

H——— Setup DIR --—-—-- #

#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)

#w EO OD 01

# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w EO OD 08

#DIR Config 2 - default

w EO OE 01

H-——- Setup DIT ----—- #

# DIT COnfig 1

# Port A data in, DIv 256

w EO 07 80

# DIT Config 2

# Default is to output to RCA

# Comment out RCA and uncomment Optical for optical outputs
#Output to RCA

# TX - ON, TX MUTE - ON, Optical disabled
#w EO 08 06

# TX Mute - OFF

#w EO 08 04

#Output to Optical

# TX - OFF, TX MUTE - ON, optical disabled
w EO 08 03

# TX MUTE - OFF
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w EO 08 01

Set P=2, J=8, D=0

EO OF 22

EO 10 1B

EO 11 A3

GPI101 Config

GP101 = RCVR non-audio data
EO 1B 06

GP102 Config

EO 1C 07
Power Status

Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down

EO 01 14

#

w

w

w

#

#

w

#

# GP102 = RCVR non-valid data
w

#

#

Hw

#w EO 03 29

253 Optical/SPDIF Input via J4 (48 kHz, RXCKO Master Clock)

# RESET RESET THIS 1S MASTER RESET FOR SRC
# SW3 (2-7) turned on, rest turned off

# Page 0 = DEFAULT for Control

# Write to page O

w EO 7F 00

# Register 01, Bit 7 = 1 resets to default
d 100

w EO 01 80

# Delay 0.1 sec to allow part to reset

d 100

# Register 01, Bit 7 = 0 for normal operation
w EO 01 00

d 100

# w EO 7F 00

# Register 01, Bit 7 = 1 resets to default
H——— Setup Port A —————- #

# 24bit 12S, Master mode, DIR source, at mute
# Divide by 256, MCLK input source

w EO 03 69

w EO 04 OB

H——— Setup DIR —-————- #

#DIR Config 1
# Input source: RX2 - S/PDIF RCA (default)

#w EO OD 01

# Input source: RX4 - S/PDIF optical, RX_MUX = RX1
w EO OD 08

#DIR Config 2 - default

w EO OE 01

Hmmm Setup DIT —-———- #

# DIT COnfig 1

# Port A data in, DIv 256

w EO 07 80

# DIT Config 2

# Default is to output to RCA
#

Commment out RCA and uncomment Optical for optical outputs

#Output to RCA
# TX - ON, TX MUTE - ON, Optical disabled
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#w EO 08 06

# TX Mute - OFF

#w EO 08 04

#0utput to Optical

#

w
#
w

H*

=== %

=S #H H = HH

#
#

# Unmute Port A Output

TX - OFF, TX MUTE - ON, optical disabled

EO 08

TX MUTE - OFF

EO 08

Set P=2, J=8, D=0

EO OF
EO 10
EO 11

GP101
GPI01
EO 1B
GP102
GP102
EO 1C

Power

03

01

22
1B
A3

Config

= RCVR non-audio data

06
Config

= RCVR non-valid data

07

Status

Disable RCVR (/PDRX) and Port B(/PDPB) power down and enable All Function power down
#w EO 01 14

w EO 03 29

# Disable All Function power down (all blocks set by local control)

w EO 01 3F

10

PCM5122EVM-U and PCM5142EVM-U

Copyright © 2012-2014, Texas Instruments Incorporated

SLAU444A—May 2012—-Revised November 2014

Submit Documentation Feedback


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU444A

13 TEXAS
INSTRUMENTS

www.ti.com CodecControl Software

3 CodecControl Software

This section explains how to use the CodecControl software together with the PCM512x and PCM514x
devices. For characteristic performance graphs, refer to the PCM512x (SLAS763) and PCM514x
(SLAS759) data sheet.

3.1 Control Software

The CodecControl software exposes most of the features of a supported Tl audio codec EVM through an
intuitive graphical user interface.

NOTE: Before a PC running Windows can use the Tl audio converter EVM as a sound card, the
EVM must be properly configured (sampling rate, audio routing, internal amplifier settings,
etc.) with the CodecControl software. This configuration occurs automatically once an EVM is
detected by the CodecControl software.

Figure 3 illustrates the CodecControl software with the PCM5122/42EVM-U window as an example of the
CodecControl software in operation.

._E:PDIF Audio Source - Sampling Rate for SRC4392
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Figure 3. EVM Software Window
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3.2

3.3

3.4

34.1

Installation

Download the CodecControl software from the PCM5122/42EVM-U audio codec product folder and launch
the program. The file is a self-extracting archive that is downloaded in a compressed format.

The default target folder is:
C:\Program Files\Texas Instruments\CodecControl

Click the Unzip button to complete the installation. The CodecControl software is now available in the
target folder. The name of the executable is CodecControl.exe.

To launch the CodecControl software, navigate to the target folder and double-click the CodecControl.exe
file.

Concepts

The CodecControl software presents a block diagram view of a supported Tl audio codec EVM, such as
that shown in Figure 3.

The block diagram consists of active objects that respond to user input (for example, switches or
amplifiers with variable gain that show a volume control when a user clicks on the component with a
mouse).

NOTE: Active Objects: Each active object changes color to red if the cursor is placed over the
object. Clicking the object triggers its function.

Some active objects are linked to control register(s) of the particular Tl audio codec. The CodecControl
software updates the appropriate register(s) whenever an active object is triggered. If a register that is
linked to an active object is changed through other components (for example, the script interpreter or the
register inspector), the active object changes its state accordingly.

The CodecControl software automatically detects a supported Tl audio codec EVM once it is connected to
an available USB port of the PC.

If no Tl audio codec EVM is connected to the PC, the control software also supports an EVM simulation
mode, where it is possible to retrieve script commands based on user input within the block diagram.

Simulation mode is only available if no Tl audio codec EVM is attached to the PC. Choose File->New
EVM simulation... and select an EVM from the list of supported Tl audio codec EVMs.

Dialogs and Active Objects

The CodecControl software contains several dialog windows that provide access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.

Several dialogs are not linked to active objects and are opened instead using the View menu.

Initialization Script Dialog
The CodecControl software executes an initialization script when a supported Tl audio codec is detected.
To show or edit the initialization script, choose View->Init Script... from the main window menu bar.

Click the Run button to run the script again.
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3.4.2 Command Dialog

Open the command dialog (View->Command...) to write, edit, load, save, and run command scripts.
Command scripts are text files that contain commands to communicate with the Tl audio codec. The
syntax is described in Section 3.5. The command dialog is shown in Figure 4.

J\Documents and Settings\a02 70557 \Desktop'PCM5142_REY_B\Codecs',PCM5101_Init.txt

Command Buffer: Read Data:

# RESET RESET THIS IS MASTER RESET FOR SRC (48kHz) -

$# Page 0 = DEFAULT for Control

§ Write to page 0

w EO0 7F 00

# Regiscer 01, Bic 7 = 1 resets to default
d 100

w EO O1 80

# Delay 0.1 sec to allow part to reset

d 100

Execute Clear

Figure 4. Command Dialog

* The primary area of the command dialog is the command buffer (editable text) which contains the
command script. Clicking the Run button runs the command script.

e The smaller, read-only text area on the right side of the command dialog displays control data read
from the Tl audio codec. The Clear button clears the Read Data field.

» The one-line text edit field on the left bottom allows single command execution.
» The Record check box enables recording of commands generated by the control software.
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3.4.3 Register Inspector

The register inspector dialog (View->Register Inspector...) gives access to all registers of the Tl audio

codec. The register inspector displays the content of the connected Tl audio codec device registers.

Clicking the Refresh button triggers reading the content of one page.

» The addr column shows the address of the registers in decimal notation.

» The description column contains a description for each register. If the register has no function
assigned, it is declared Reserved.

* The data columns show the data of each register (one byte). The first data column uses decimal
notation, and the second uses hexadecimal notation. It is possible to change the register value by
clicking into one of the data fields and typing the new value (either decimal or hexadecimal).

* The numbered columns show the register content in binary notation. Read/write bits are shown solid
black or red; read-only bits are gray or dark red. Red numbers represent bits that recently changed.
Change a single writable bit by clicking on the bit and it flips.

The coefficients may be used for a specific customer filter implementation. The format is compatible with

the Tl audio codec that was detected by the CodecControl software.

NOTE: This feature is not used for the PCM510x, which are hardware programmable only.

3.4.4 Firmware Update

Tl may publish new firmware for Tl audio codec EVMs. Program the new firmware to a Tl audio codec

EVM by choosing File->Update Firmware... and select the new firmware file.

The update process takes a few seconds (there is no progress bar) and is completed once the update

firmware dialog disappears. The EVM must be disconnected and reconnected to finish the firmware

update process.
3.5 Script Syntax

A script is a text file that contains data to send to a device.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except

for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:

r Read from the serial control bus
w  Write to the serial control bus

> Extend repeated write commands
# Comment

I Set interface bus to use

b Break

d Delay

f Wait for Flag

Command: r <address> <register> <length>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is read from in hexadecimal format.
<length> is the number of bytes that are read from <register> in auto-increment mode.

The result is displayed in the right-side output window of the command interpreter dialog.

Command: w <address> <register> <data ...>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is written to in hexadecimal format.
<data...> is a sequence of bytes that are written to the <register> in auto-increment mode. Each byte
is in hexadecimal format.
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Command: > <data ...>
This command continues a write sequence in a new line.
<data...> is a sequence of bytes that is written in auto-increment mode. Each byte is in hexadecimal
format.
Command: # [optional comment]
This command indicates a comment.

Command: I<interface>
<interface> is i2c for 1°C or spi for SPI.

Command: b[optional comment]
[optional comment] is a string of characters. The command interpreter shows a modal dialog with the
optional comment. Script execution resumes once the dialog is closed.

Command: d<time>
This command suspends script execution by at least <time> milliseconds.

Command: f <address> <register> <mask> [optional timeout]

This commands suspends script execution until the value read from <address> <register> matches
<mask>.

<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register that is read from in hexadecimal format.

<mask> is a 8-bit binary format mask that is compared with the data from the device. Each bit can be
0,1, or X.

For example: <mask> = 010XX01X tests, if the data from the device has D7 =0, D6 =1, D5 =0, D4 =
don’t care, D3 = don’t care, D2 =0, D1 = 1, DO = don't care.

[optional timeout] specifies how long (milliseconds) the command interpreter polls the device if the data
do not match the <mask>.
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4 Schematics and Bill of Materials (BOM)

4.1

41.1

PCM512xEVM-U

PCM512xEVM-U Schematics

Figure 5 through Figure 7 show the schematics for the PCM5122EVM-U.

GPIO4

Figure 5. PCM512xEVM-U Schematic
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Figure 6. PCM512xEVM-U Power and USB Controller
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Figure 7. PCM512xEVM-U Digital 1/0 and Source

4.1.2 PCM512xEVM-U Bill of Materials
Table 3 is the BOM for the PCM512xEVM-U.
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Table 3. PCM512xEVM-U Bill of Materials®®@®

Item MFG Part Number MFG QTY Ref Designators Description
1 PCM5122PW TEXAS INSTRUMENTS 1 U1 24-BIT 384KHz AUDIO STEREO DAC w/MINI DSP TSSOP28-PW ROHS
2 TPS73618DBVT TEXAS INSTRUMENTS 1 u2 VOLT REG 1.8V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS
3 TPS73633DBVT TEXAS INSTRUMENTS 1 () VOLT REG 3.3V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS
4 TPS2553DBV TEXAS INSTRUMENTS 1 U4 Adj.,Active High,Pwr-Dist Switch,SOT23-DBV6,ROHS
5 TAS1020BPFB TEXAS INSTRUMENTS 1 U6 USB STREAMING CONTROLLER TQFP48-PFB ROHS
6 SN74LVC138APWR TEXAS INSTRUMENTS 1 u7 3-LINE TO 8-LINE DECODER/DEMULTIPLEXER TSSOP16-PW ROHS
7 SN74LVC1G125DBVR TEXAS INSTRUMENTS 3 us, U9, U1l SINGLE BUS BUFFER GATE WITH 3-STATE OUTPUT SOT23-DBV5 ROHS
8 SN74LVC2G04DBVR TEXAS INSTRUMENTS 1 u1o0 DUAL INVERTER GATE SOT23-DBV6 ROHS
9 SRC4392IPFBR BURR-BROWN 1 u12 2 CHAN,ASYNC,SAMPLE RATE CONV W/DIG AUDIO REC/XMTR ROHS
10 24FC512-1/SM MICROCHIP 1 us 512K (64Kx8) 12C SERIAL EEPROM SOIC8-SM ROHS
11 PLR135/T10 EVERLIGHT ELECTRONICS 1 J4 PHOTOLINK FIBER OPTIC RECEIVER 2.4-5.5V 15MB PCB-RA SHUTTER ROHS
12 SML-LXTO0805YW-TR LUMEX OPTO 1 D1 LED, YELLOW 2.0V SMD0805 ROHS
13 SML-LXTO805GW-TR LUMEX OPTO 2 D2, D3 LED, GREEN 2.0V SMD0805 ROHS
14 SIT8002AI-13-33E-6.00000T SITIME 1 Y1 OSCILLATOR SMT 6MHz 3.3V OUT-ENABLE ROHS
15 SM7745HSV-22.5792M PLETRONICS 1 Y2 OSCILLATOR SMT 3.3V SM77H SERIES 22.5792MHz ROHS
16 SM7745HSV-24.576M PLETRONICS 1 Y3 OSCILLATOR SMT 3.3V SM77H SERIES 24.576MHz ROHS
17 EEE1CA100SR PANASONIC 0 C1, C3, C7,C11 CAP SMD ELECT 10ufd 16V 20% VS-B ROHS
18 C2012X7R2A104K TDK 4 C2, C4, C6, C10 CAP SMD0805 CERM 0.1UFD 100V 10% X7R ROHS
19 GCM21BR71E225KA73L MURATA 2 C8, C9 CAP SMD0805 CERM 2.2UFD 25V 10% X7R ROHS
20 GRM188R71H222KA01D MURATA 2 C12,C13 CAP SMD0603 CERM 2200PFD 50V 10% X7R ROHS
21 GRM21BR61C106KE15L MURATA 4 C14, C16, C17, C19 CAP SMD0805 CERM 10UFD 16V 10% X5R ROHS
22 C1608X7R1H104K TDK 20 C15, C18, C20, C22, C25, C28, C30, C31, C32, | CAP SMD0603 CERM 0.1UFD 50V 10% X7R ROHS

C33, C35, C36, C37, C41, C43, C44, C46, C47,

C48, C49
23 UKZ1E101MPM NICHICON 1 Cc21 CAP ALUM ELEC KZ RADIAL 100UFD 50V 20% ROHS
24 GRM2165C1H101JA01D MURATA 1 c23 CAP SMD0805 CERM 100PFD 50V 5% COG ROHS
25 C1608C0G1H102J TDK CORP. 1 C24 CAP SMD0603 CERM 1000PFD 50V 5% COG ROHS
26 GRM1885C1H470JA01D MURATA 2 C26, C27 CAP SMD0603 CERM 47PFD 50V 5% COG ROHS
27 C1608X7R1C105K TDK 1 C29 CAP SMD0603 CERM 1.0UFD 16V 10% X7R ROHS
28 GRM188R60J106 ME47D MURATA 2 C34, C45 CAP SMD0603 CERM 10UFD 6.3V 20% X5R ROHS
29 C2012X5R0J226M TDK 3 C38, C40, C42 CAP SMD0805 CERM 22UFD 6.3V 20% X5R ROHS
30 06031C103JAT2A AVX 1 C39 CAP SMD0603 CERM 0.01UFD 25V 5% X7R ROHS
31 ERJ-3GEYJ103V PANASONIC 9 RO, R3, R4, R5, R16, R17, R20, R21, R22 RESISTOR SMD0603 10K 5% 1/10W ROHS
32 ERJ-3GEYJ471V PANASONIC 2 R1, R2 RESISTOR SMD0603 470 OHMS 5% 1/10W ROHS
33 ERJ-3EKF1003V PANASONIC 17 R6, R14, R40, R41, R42, R43, R44, R45, R46, RESISTOR SMD0603 100K OHM 1% THICK FILM 1/10W ROHS

R47, R48, R49, R50, R51, R52, R53, R54
34 ERJ-8GEYOROOV PANASONIC 1 R7 RESISTOR SMD1206 0.0 OHM 5% 1/4W ROHS
35 ERJ-3GEYJ272V PANASONIC 2 R8, R9 RESISTOR SMD0603 2.7K OHMS 5% 1/10W ROHS
36 ERJ-3EKF3091V PANASONIC 1 R10 RESISTOR SMD0603 3.09K OHM 1% THICK FILM 1/10W ROHS

(6]
()
@®)

These assemblies are ESD sensitive, observe ESD precautions.

These assemblies must be clean and free from flux and all contaminants. Use of no-clean flux is not acceptable.
These assemblies must comply with workmanship standards IPC-A-610 Class 2.
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Table 3. PCM512xEVM-U Bill of Materials®®® (continued)

Item MFG Part Number MFG QTY Ref Designators Description
37 ERJ-3EKF1501V PANASONIC 1 R11 RESISTOR SMDO0603 1.50K OHM 1% THICK FILM 1/10W ROHS
38 ERJ-3EKF27R4V PANASONIC 2 R12, R13 RESISTOR SMDO0603 27.4 OHMS 1% 1/10W ROHS
39 RCO0603FR-07649RL YAGEO 1 R15 RESISTOR SMD0603 THICK FILM 649 OHMS 1% 1/10W ROHS
40 ERJ-8ENF10R0 PANASONIC 5 R18, R23, R25, R30, R31 RESISTOR SMT1206 10.0 OHM 1% 1/4W ROHS
41 MCR18EZPF75R0 ROHM SEMICONDUCTOR 2 R19, R24 RESISTOR SMD1206 75 OHMs 1% 1/4W ROHS
42 ERJ-3EKF33ROV PANASONIC 4 R26, R27, R28, R29 RESISTOR SMD0603 33.0 OHMS 1% 1/10W ROHS
43 CRCWO060322R1FKEA VISHAY 2 R32, R33 RESISTOR SMD0603 22.1 OHMS 1% 1/10W ROHS
44 ERJ-3GEYJ472V PANASONIC 1 R34 RESISTOR SMDO0603 4.7K OHMS 5% 1/10W ROHS
45 RCJ-042 CUI STACK 1 Jl RCA JACK THRU RA-FEMALE RED ROHS
46 RCJ-043 CUI STACK 1 J2 RCA JACK THRU RA-FEMALE WHITE ROHS
47 UX60-MB-5ST HIROSE 1 J3 JACK USB MINIB SMT-RA 5PIN ROHS
48 RCJ-047 CUI STACK 1 J5 RCA JACK THRU RA-FEMALE ORANGE ROHS
49 5227699-2 TYCO ELECTRONICS 1 J6 JACK BNC SQUARE 50 OHMS ROHS
50 PBCO3SAAN SULLINS 3 W1, W2, W5 HEADER THRU MALE 3 PIN 100LS 120 TAIL GOLD ROHS
51 PBC15DAAN SULLINS 1 W3 HEADER THRU MALE 2X15 100LS 120 TAIL GOLD ROHS
52 PBC02DAAN SULLINS 1 W4 HEADER THRU MALE 2X2 PIN 100LS 120 TAIL GOLD ROHS
53 5002 KEYSTONE ELECTRONICS 23 TP1, TP2, TP3, TP4, TP5, TP6, TP7, TP8, TP9, | PC TESTPOINT, WHITE, ROHS
TP10, TP11, TP12, TP13, TP14, TP15, TP16,
TP17, TP27, TP28, TP29, TP30, TP31, TP32
54 5000 KEYSTONE ELECTRONICS 3 TP18, TP19, TP20 PC TESTPOINT, RED, ROHS
55 5011 KEYSTONE ELECTRONICS 6 TP21, TP22, TP23, TP24, TP25, TP26 PC TESTPOINT BLACK 063 HOLE ROHS
56 EVQ-5PN04K PANASONIC 2 SW1, Sw2 SWITCH MOM 240G SMD 6x3.5MM ROHS
57 TDA04HOSB1 CK COMPONENTS 1 SW3 SWITCH SMT DIP8 4POS ROHS
58 95947A018 MCMASTER-CARR 4 STANDOFFS STANDOFF M3x25mm 4.5mm DIA HEX ALUM F-F ROHS
59 92148A150 MCMASTER-CARR 4 STANDOFF WASHERS WASHER SPLIT-LOCK M3 6.2mm OD 0.7mm THICK STAINLESS STEEL ROHS
60 92000A118 MCMASTER-CARR 4 STANDOFF SCREWS SCREW M3x8 PHILIPS PANHEAD STAINLESS STEEL ROHS
61 969102-0000-DA 3M 4 W1(2-3), W2(2-3), W4(1-2), W5(1-2) SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS
62 969102-0000-DA 3M 12 Wa3: 1-2, 3-4, 5-6, 7-8, 9-10, 15-16, 17-18, 19- SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS
20, 21-22, 23-24, 25-26, 29-30
TOTAL 186
X1 DO NOT POPULATE 4 C1, C3,C7,C11
4.2 PCM514xEVM-U
42.1 PCM514xEVM-U Schematics

Figure 8 through Figure 10 show the schematics for the PCM5122EVM-U.

20 PCM5122EVM-U and PCM5142EVM-U
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Figure 9. PCM514xEVM-U Power and USB Controller
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PCM514xEVM-U Bill of Materials

Figure 10. PCM514xEVM-U Digital I1/0 and Source

Table 4 is the BOM for the PCM514xEVM-U.
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Table 4. PCM514xEVM-U Bill of Materials ®®®

Item MFG Part Number MFG QTY Ref Designators Description
1 PCM5142PW TEXAS INSTRUMENTS 1 [OX8 24-BIT 384KHz AUDIO STEREO DAC w/MINI DSP TSSOP28-PW ROHS
2 TPS73618DBVT TEXAS INSTRUMENTS 1 u2 VOLT REG 1.8V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS
3 TPS73633DBVT TEXAS INSTRUMENTS 1 u3 VOLT REG 3.3V 400MA LDO CAP FREE NMOS SOT23-DBV5 ROHS
4 TPS2553DBV TEXAS INSTRUMENTS 1 U4 Adj.,Active High,Pwr-Dist Switch,SOT23-DBV6,ROHS
5 TAS1020BPFB TEXAS INSTRUMENTS 1 u6 USB STREAMING CONTROLLER TQFP48-PFB ROHS
6 SN74LVC138APWR TEXAS INSTRUMENTS 1 u7 3-LINE TO 8-LINE DECODER/DEMULTIPLEXER TSSOP16-PW ROHS
7 SN74LVC1G125DBVR TEXAS INSTRUMENTS 3 us, U9, Ul11 SINGLE BUS BUFFER GATE WITH 3-STATE OUTPUT SOT23-DBV5 ROHS
8 SN74LVC2G04DBVR TEXAS INSTRUMENTS 1 u10 DUAL INVERTER GATE SOT23-DBV6 ROHS
9 SRC4392IPFBR BURR-BROWN 1 u12 2 CHAN,ASYNC,SAMPLE RATE CONV W/DIG AUDIO REC/XMTR ROHS
10 24FC512-1/SM MICROCHIP 1 us 512K (64Kx8) 12C SERIAL EEPROM SOIC8-SM ROHS
11 PLR135/T10 EVERLIGHT ELECTRONICS 1 J4 PHOTOLINK FIBER OPTIC RECEIVER 2.4-5.5V 15MB PCB-RA SHUTTER ROHS
12 SML-LXT0805YW-TR LUMEX OPTO 1 D1 LED, YELLOW 2.0V SMD0805 ROHS
13 SML-LXTO805GW-TR LUMEX OPTO 2 D2, D3 LED, GREEN 2.0V SMD0805 ROHS
14 SIT8002AI-13-33E-6.00000T SITIME 1 Y1 OSCILLATOR SMT 6MHz 3.3V OUT-ENABLE ROHS
15 SM7745HSV-22.5792M PLETRONICS 1 Y2 OSCILLATOR SMT 3.3V SM77H SERIES 22.5792MHz ROHS
16 SM7745HSV-24.576M PLETRONICS 1 Y3 OSCILLATOR SMT 3.3V SM77H SERIES 24.576MHz ROHS
17 EEE1CA100SR PANASONIC 0 C1, C3,C7,C11 CAP SMD ELECT 10ufd 16V 20% VS-B ROHS
18 C2012X7R2A104K TDK 4 C2, C4, C6, C10 CAP SMD0805 CERM 0.1UFD 100V 10% X7R ROHS
19 GCM21BR71E225KA73L MURATA 2 Cs8, C9 CAP SMD0805 CERM 2.2UFD 25V 10% X7R ROHS
20 GRM188R71H222KA01D MURATA 2 C12, C13 CAP SMD0603 CERM 2200PFD 50V 10% X7R ROHS
21 GRM21BR61C106KE15L MURATA 4 C14, C16, C17, C19 CAP SMD0805 CERM 10UFD 16V 10% X5R ROHS
22 C1608X7R1H104K TDK 20 C15, C18, C20, C22, C25, C28, C30, C31, CAP SMD0603 CERM 0.1UFD 50V 10% X7R ROHS
C32, C33, C35, C36, C37, C41, C43, C44,
C46, C47, C48, C49
23 UKZ1E101MPM NICHICON 1 Cc21 CAP ALUM ELEC KZ RADIAL 100UFD 50V 20% ROHS
24 GRM2165C1H101JA01D MURATA 1 Cc23 CAP SMD0805 CERM 100PFD 50V 5% COG ROHS
25 C1608C0G1H102J TDK CORP. 1 c24 CAP SMD0603 CERM 1000PFD 50V 5% COG ROHS
26 GRM1885C1H470JA01D MURATA 2 C26, C27 CAP SMD0603 CERM 47PFD 50V 5% COG ROHS
27 C1608X7R1C105K TDK 1 C29 CAP SMD0603 CERM 1.0UFD 16V 10% X7R ROHS
28 GRM188R60J106ME47D MURATA 2 C34, C45 CAP SMD0603 CERM 10UFD 6.3V 20% X5R ROHS
29 C2012X5R0J226M TDK 3 C38, C40, C42 CAP SMD0805 CERM 22UFD 6.3V 20% X5R ROHS
30 06031C103JAT2A AVX 1 C39 CAP SMD0603 CERM 0.01UFD 25V 5% X7R ROHS
31 ERJ-3GEYJ103V PANASONIC 9 RO, R3, R4, R5, R16, R17, R20, R21, R22 RESISTOR SMD0603 10K 5% 1/10W ROHS
32 ERJ-3GEYJ471V PANASONIC 2 R1, R2 RESISTOR SMD0603 470 OHMS 5% 1/10W ROHS
33 ERJ-3EKF1003V PANASONIC 17 R6, R14, R40, R41, R42, R43, R44, R45, RESISTOR SMD0603 100K OHM 1% THICK FILM 1/10W ROHS
R46, R47, R48, R49, R50, R51, R52, R53,
R54
34 ERJ-8GEYOROOV PANASONIC 1 R7 RESISTOR SMD1206 0.0 OHM 5% 1/4W ROHS
35 ERJ-3GEYJ272V PANASONIC 2 R8, R9 RESISTOR SMD0603 2.7K OHMS 5% 1/10W ROHS

63
@
3

These assemblies are ESD sensitive, observe ESD precautions.

These assemblies must be clean and free from flux and all contaminants. Use of no-clean flux is not acceptable.
These assemblies must comply with workmanship standards IPC-A-610 Class 2.
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Table 4. PCM514xEVM-U Bill of Materials®®® (continued)

Item MFG Part Number MFG QTY Ref Designators Description
36 ERJ-3EKF3091V PANASONIC 1 R10 RESISTOR SMD0603 3.09K OHM 1% THICK FILM 1/10W ROHS
37 ERJ-3EKF1501V PANASONIC 1 R11 RESISTOR SMD0603 1.50K OHM 1% THICK FILM 1/10W ROHS
38 ERJ-3EKF27R4V PANASONIC 2 R12, R13 RESISTOR SMD0603 27.4 OHMS 1% 1/10W ROHS
39 RCO0603FR-07649RL YAGEO 1 R15 RESISTOR SMD0603 THICK FILM 649 OHMS 1% 1/10W ROHS
40 ERJ-8ENF10R0 PANASONIC 5 R18, R23, R25, R30, R31 RESISTOR SMT1206 10.0 OHM 1% 1/4W ROHS
41 MCR18EZPF75R0 ROHM SEMICONDUCTOR 2 R19, R24 RESISTOR SMD1206 75 OHMs 1% 1/4W ROHS
42 ERJ-3EKF33R0OV PANASONIC 4 R26, R27, R28, R29 RESISTOR SMDO0603 33.0 OHMS 1% 1/10W ROHS
43 CRCWO060322R1FKEA VISHAY 2 R32, R33 RESISTOR SMD0603 22.1 OHMS 1% 1/10W ROHS
44 ERJ-3GEYJ472V PANASONIC 1 R34 RESISTOR SMD0603 4.7K OHMS 5% 1/10W ROHS
45 RCJ-042 CUI STACK 1 J1 RCA JACK THRU RA-FEMALE RED ROHS
46 RCJ-043 CUI STACK 1 J2 RCA JACK THRU RA-FEMALE WHITE ROHS
47 UX60-MB-5ST HIROSE 1 J3 JACK USB MINIB SMT-RA 5PIN ROHS
48 RCJ-047 CUI STACK 1 J5 RCA JACK THRU RA-FEMALE ORANGE ROHS
49 5227699-2 TYCO ELECTRONICS 1 J6 JACK BNC SQUARE 50 OHMS ROHS
50 PBCO3SAAN SULLINS 3 W1, W2, W5 HEADER THRU MALE 3 PIN 100LS 120 TAIL GOLD ROHS
51 PBC15DAAN SULLINS 1 w3 HEADER THRU MALE 2X15 100LS 120 TAIL GOLD ROHS
52 PBCO2DAAN SULLINS 1 w4 HEADER THRU MALE 2X2 PIN 100LS 120 TAIL GOLD ROHS
53 5002 KEYSTONE ELECTRONICS 23 TP1, TP2, TP3, TP4, TP5, TP6, TP7, TP8, PC TESTPOINT, WHITE, ROHS
TP9, TP10, TP11, TP12, TP13, TP14, TP15,
TP16, TP17, TP27, TP28, TP29, TP30, TP31,
TP32
54 5000 KEYSTONE ELECTRONICS 3 TP18, TP19, TP20 PC TESTPOINT, RED, ROHS
55 5011 KEYSTONE ELECTRONICS 6 TP21, TP22, TP23, TP24, TP25, TP26 PC TESTPOINT BLACK 063 HOLE ROHS
56 EVQ-5PNO4K PANASONIC 2 SW1, SwW2 SWITCH MOM 240G SMD 6x3.5MM ROHS
57 TDA04HOSB1 CK COMPONENTS 1 Sw3 SWITCH SMT DIP8 4POS ROHS
58 95947A018 MCMASTER-CARR 4 STANDOFFS STANDOFF M3x25mm 4.5mm DIA HEX ALUM F-F ROHS
59 92148A150 MCMASTER-CARR 4 STANDOFF WASHERS WASHER SPLIT-LOCK M3 6.2mm OD 0.7mm THICK STAINLESS STEEL ROHS
60 92000A118 MCMASTER-CARR 4 STANDOFF SCREWS SCREW M3x8 PHILIPS PANHEAD STAINLESS STEEL ROHS
61 969102-0000-DA 3M 4 W1(2-3), W2(2-3), W4(1-2), W5(1-2) SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS
62 969102-0000-DA 3M 12 Wa3: 1-2, 3-4, 5-6, 7-8, 9-10, 15-16, 17-18, 19- | SHUNT BLACK AU FLASH 0.100LS OPEN TOP ROHS
20, 21-22, 23-24, 25-26, 29-30
TOTAL 186
X1 DO NOT POPULATE 4 C1,C3,C7,C11
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13 TEXAS
INSTRUMENTS

www.ti.com Schematics and Bill of Materials (BOM)

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other
changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESDA48, latest
issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and
complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI's terms and conditions of sale
supplied at the time of order acknowledgment.

Tl warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms
and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent Tl deems necessary
to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily
performed.

Tl assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information
published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or
endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration
and is accompanied by all associated warranties, conditions, limitations, and notices. Tl is not responsible or liable for such altered
documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by Tl for that component or service
voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice.
Tl is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which
anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause
harm and take appropriate remedial actions. Buyer will fully indemnify Tl and its representatives against any damages arising out of the use
of any Tl components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI's goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.

No Tl components are authorized for use in FDA Class Ill (or similar life-critical medical equipment) unless authorized officers of the parties
have executed a special agreement specifically governing such use.

Only those Tl components which Tl has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components
which have not been so designated is solely at the Buyer's risk, and that Buyer is solely responsible for compliance with all legal and
regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, Tl will not be responsible for any failure to meet ISO/TS16949.

Products Applications

Audio www.ti.com/audio Automotive and Transportation www.ti.com/automotive
Amplifiers amplifier.ti.com Communications and Telecom  www.ti.com/communications
Data Converters dataconverter.ti.com Computers and Peripherals www.ti.com/computers
DLP® Products www.dlp.com Consumer Electronics www.ti.com/consumer-apps
DSP dsp.ti.com Energy and Lighting www.ti.com/energy

Clocks and Timers www.ti.com/clocks Industrial www.ti.com/industrial
Interface interface.ti.com Medical www.ti.com/medical

Logic logic.ti.com Security www.ti.com/security

Power Mgmt power.ti.com Space, Avionics and Defense www.ti.com/space-avionics-defense
Microcontrollers microcontroller.ti.com Video and Imaging www.ti.com/video

RFID www.ti-rfid.com

OMAP Applications Processors www.ti.com/omap TI E2E Community e2e.ti.com

Wireless Connectivity www.ti.com/wirelessconnectivity

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
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STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES

Delivery: Tl delivers Tl evaluation boards, kits, or modules, including any accompanying demonstration software, components, or
documentation (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms and conditions set forth herein.
Acceptance of the EVM is expressly subject to the following terms and conditions.

11

1.2

EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of Tl semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms and conditions that accompany such Software

EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

Limited Warranty and Related Remedies/Disclaimers:

21

2.2

2.3

These terms and conditions do not apply to Software. The warranty, if any, for Software is covered in the applicable Software
License Agreement.

Tl warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date Tl delivers such EVM
to User. Notwithstanding the foregoing, Tl shall not be liable for any defects that are caused by neglect, misuse or mistreatment
by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any
way by an entity other than TI. Moreover, Tl shall not be liable for any defects that result from User's design, specifications or
instructions for such EVMs. Testing and other quality control techniques are used to the extent Tl deems necessary or as
mandated by government requirements. TI does not test all parameters of each EVM.

If any EVM fails to conform to the warranty set forth above, TI's sole liability shall be at its option to repair or replace such EVM,
or credit User's account for such EVM. Tl's liability under this warranty shall be limited to EVMs that are returned during the
warranty period to the address designated by Tl and that are determined by TI not to conform to such warranty. If Tl elects to
repair or replace such EVM, Tl shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall
be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

Regulatory Notices:

3.1

United States
3.1.1 Notice applicable to EVMs not FCC-Approved:

This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit
to determine whether to incorporate such items in a finished product and software developers to write software applications for
use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless
all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause
harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is
designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of
an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC — FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or madifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.



3.2

3.3

FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

« Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
« Consult the dealer or an experienced radio/TV technician for help.

Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210
Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) I'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour I'‘émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas lintensité nécessaire a I'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d'usage et ayant un gain admissible maximal et I'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour I'exploitation de
I'émetteur

Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page BAEMAIZ
BATNDFHMEAFY b, R—RIZOVTRK, KOECAZEZEBLSEE,
http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan are NOT certified by
Tl as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, User is required by Radio Law of Japan to follow the instructions below with respect to EVMs:

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’'s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan

with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
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3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page
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Lo http://lwww.tij.co.jp/Isdsl/ti_ja/general/eStore/notice_02.page

4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by Tl regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by Tl, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a Tl
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a Tl field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent Tl provides information on the availability and function of EVMs, Tl attempts to be as accurate
as possible. However, Tl does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.
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6.

10.

Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY WRITTEN DESIGN MATERIALS PROVIDED WITH THE EVM (AND THE
DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." Tl DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY
THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS AND
CONDITIONS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY
OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD
PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY
INVENTION, DISCOVERY OR IMPROVEMENT MADE, CONCEIVED OR ACQUIRED PRIOR TO OR AFTER DELIVERY OF
THE EVM.

USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS AND CONDITIONS. THIS OBLIGATION
SHALL APPLY WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY
OTHER LEGAL THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS ANDCONDITIONS OR THE USE OF THE EVMS PROVIDED HEREUNDER, REGARDLESS OF WHETHER TI HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED
TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS,
LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL
BE BROUGHT AGAINST TI MORE THAN ONE YEAR AFTER THE RELATED CAUSE OF ACTION HAS OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY WARRANTY OR OTHER OBLIGATION
ARISING OUT OF OR IN CONNECTION WITH THESE TERMS AND CONDITIONS, OR ANY USE OF ANY TI EVM
PROVIDED HEREUNDER, EXCEED THE TOTAL AMOUNT PAID TO TI FOR THE PARTICULAR UNITS SOLD UNDER
THESE TERMS AND CONDITIONS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE
OF MORE THAN ONE CLAIM AGAINST THE PARTICULAR UNITS SOLD TO USER UNDER THESE TERMS AND
CONDITIONS SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

Return Policy. Except as otherwise provided, Tl does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated



IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other
changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESDA48, latest
issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and
complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI's terms and conditions of sale
supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms
and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent Tl deems necessary
to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily
performed.

Tl assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information
published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or
endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the
third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of significant portions of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration
and is accompanied by all associated warranties, conditions, limitations, and notices. Tl is not responsible or liable for such altered
documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service
voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice.
Tl is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which
anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause
harm and take appropriate remedial actions. Buyer will fully indemnify Tl and its representatives against any damages arising out of the use
of any Tl components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI's goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.

No Tl components are authorized for use in FDA Class Ill (or similar life-critical medical equipment) unless authorized officers of the parties
have executed a special agreement specifically governing such use.

Only those Tl components which Tl has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components
which have not been so designated is solely at the Buyer's risk, and that Buyer is solely responsible for compliance with all legal and
regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, Tl will not be responsible for any failure to meet ISO/TS16949.
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Computers and Peripherals
Consumer Electronics
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Medical

Security

Space, Avionics and Defense
Video and Imaging
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www.ti.com/computers

www.ti.com/consumer-apps

www.ti.com/energy
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